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Overview of Contact Browser

Contact Browser is a personal address and phone number management system. Contact Browser 
includes the following features:

Maintains a database of a personal and/or business contacts including address 
information, most commonly used phone numbers, personal dates such as birthdays 
and anniversaries, electronic mail ID's, and general comments about the contact. See 
the topic Browse Window for more information.

Contact Browser's database supports the Microsoft® Open Database Connectivity 
(ODBC) specification.

Categorize each record. Contact Browser allows you to define your own categories so 
you can easily group your contacts. For example, you might have a Category for 
business contacts, one for family, another for friends, and maybe another category for 
a Christmas card list.

Browse, Add ,Delete, or change records via a Browse Window. All of the database 
information is on one easy to read screen for quick access to information.

Contact Browser features a fully customizable Export option. Define your own export 
format; specify which fields to export, select individual contacts to export, export by 
category, or select ranges of contacts to export. Choose from TAB delimited or Comma
Separated file formats.

Contact Browser's Import feature is powerful and easy to use. You can Import from 
comma separated or TAB delimited file formats. Individually match your import data to   
Contact Browser fields.

Find records by searching on one or more of the following fields: last name, first name,
company, state, city, zipcode, or country. Use the Find Next feature to continue 
searching for additional matches.

Features automatic phone number dialing at the push of a single button, as well as a 
Dialer dialog for custom dialing phone numbers.

Print the currently displayed record.

Print laser printer or dot-matrix Labels. You select the contacts you want to print labels 
for, choose from over 27 standard Avery label formats or define your own format, 
select your own font, even add your own custom text to print on the labels.

Create custom reports. Contact Browser's reports are fully customizable to your 
needs. You can select the fields you want to display on a report, in the order you want, 
select a single record or all records, set limits to filter the information that will be 
displayed, sort the report in any order, choose your own fonts, print reports in 
landscape or portrait modes, and Print Preview reports.

Information displayed on reports can be copied to the Windows™ clipboard in a TAB 



delimited format. This information can then be pasted into other applications such as 
the Microsoft® Excel® spreadsheet program.



How To Reach Me

I hope you enjoy Contact Browser and get a lot of use out of it. If you have any questions, suggestions or 
comments, please write me at the following address:

Moore Software Solutions
Attn: Ric Moore
P.O. Box 501783
San Diego, Ca 92150-1783

On-line support is available on-line at the following locations:

Compuserve: 72774,3705
America On-Line: Moore Soft
Internet: mooresoft@aol.com

To register this copy of Contact Browser, or to order additional copies, select Order Contact Browser from 
the help menu.

Contact Browser, Copyright © 1994 Moore Software Solutions. All rights reserved
Microsoft ® Windows™ is a Trademark of Microsoft Corporation.



File menu commands

The File menu offers the following commands:

Close Closes an opened document.
Print Prints a document.
Print Preview Displays the document on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
Import Import information from an ASCII file.
Export Export information to an ASCII file.
Exit Exits Contact Browser.



Edit menu commands

The Edit menu offers the following commands:

Copy Copies data from the document to the clipboard.
Categories Add, change and delete categories



Dial menu commands

The Dial menu offers the following commands:

Call Dial a phone number.
Settings Sets the dial settings.

Reports menu commands

The Reports menu offers the following commands:

New Report Create reports from the Contact Browser's database.
Labels Create labels.
Sort Sort a report in any order.
Font Select a font for the report.



 Options menu commands

Show ToolTips Show or hide ToolTips.
Auto Save Changes Toggle auto save mode.
Browse Window Choose from a selection of specialized browse windows.

View menu commands

The View menu offers the following commands:

Index Bar Shows or hides the index bar.
Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using Help Provides general instructions on using help.
Order Contact Browser Register or order additional copies of Contact Browser.
About Displays the version number of this application.



Reports

Contact Browser offers fully customizable reports. You can select the specific fields you want to 
display on a report, in the order you want, select a single record or all records, set limits to filter 
the information that will be displayed, and sort the report by any three fields. 

For example, if you travel on business and use Contact Browser to keep track of all your business 
contacts, it would be useful to run a report an all your contacts in a particular state, limit it to business 
contacts only, and sort the list by Company Name, Last Name, and then First Name.

Reports are created by selecting New Report from the Reports menu.The Report Table is displayed in a 
spreadsheet like grid format in which you can adjust the column widths, select individual or multiple rows 
for printing or copying to the clipboard, select your own font, and sort by any three columns.

Shortcut

Toolbar:
Keys: CTRL+R

See also: Reports dialog



Report Table

The report table is a spreadsheet like form used to display the report information. The table's columns are
resizable so you can adjust their widths to fit the information that is displayed in them.
Rows can be selected by clicking on the row number button or using the arrow keys to move to the line an
pressing the space bar. Selected rows can then be copied to the clipboard by pressing Ctrl + C on the 
keyboard.
You can print the report by choosing Print form the File menu or preview what the report will look like 
printed by choosing Print Preview from the File menu.You can also print certain rows on the report by 
selecting them and then issuing the File Print command. (If there are any rows selected in the table, Print 
Preview will only preview those lines).
You can change the font for the table by selecting the Font command from the Reports menu. This feature
is useful for fitting more information on a printed page by making the font for the table smaller.
You can also sort the table by any three columns by choosing Sort from the Reports menu.



Choose Font dialog box

Use the Font dialog box to select a font and its characteristics to use in the current report.
The Sample box shows the font in the selected style and size, as it will appear in windows on your 
display.

Options

Font
Select a font from the list displayed. This are the fonts installed with Windows on your computer. You 
can select a font or type the name of the font you want in the box above the list of fonts.

Font Style
Select a style from the list displayed for the chosen font. The list displayed depends on the installed 
font. Besides regular, you may be able to choose bold, italic, or combined bold and italic styles.

Size
Select a point size from the list displayed for the chosen font. The sizes available depend on the 
chosen font. You can select a font size or type the size you want in the box above the list of sizes.
Some fonts can be displayed larger or smaller than the standard size options available in the list. To 
see if a font supports a different size than one that is listed type the size you want an press the TAB 
key and see if the sample changes.



Browse Window

The Browse Window gives you a view of records in the Contact Browser database. Through the 
Browse Window you can move through the database a record at a time, Find a particular record in the 
database, edit the record currently being viewed, or Add and Delete records from the database. The 
Browse Window also allows you to dial phone numbers using the Dial Button in the Phone Numbers 
section of the Browse Window. The Browse Window is divided into 5 sections:

Address Information
Dates to Remember
Phone Numbers
E-Mail ID
General Comments

You can choose from 5 different browse windows; Complete (default), Simple Personal, Enhanced 
Personal, Simple Business, or Enhanced Business. To change to a different browse window, choose 
Browse Window from the Options menu. 
See also Browse Window Sort Order, Browse Window Options



Browse Window Sort Order

The order in which information is displayed in the Browse Window is by Last Name, First Name, and 
Company, respectively. Contact Browser uses the ASCII character set to determine the sort order. 

Here are the general rules for the sort order:

Spaces come before numbers and alphabetic characters in the ASCII character set so if a record does 
not have a Last Name, it will come before all records that do have a Last Name.

Numbers come between spaces and alphabetic characters in the ASCII character set so if a record has a 
number in the Last Name, it will come after records with no Last Name but before records with alphabetic 
characters in the Last Name.

Records that have no First or Last Name i.e. business contacts, will come before all records that have 
anything in the First or Last Name fields. These records will be at the beginning of the database and 
sorted by the Company Name.

The Index bar along the top of the Browse Window can be used to gain direct access to the first record to 
have a Last Name that begins with the character pressed.



Category

You can use categories to group similar types of contacts together. For example, you might use a 
category "Family/Friends" to group together your personal contacts, and a category of "Business" to 
group together all your business contacts. Categories are useful when running reports and you only want 
to see certain types of contacts on the listing.
When entering a contact, you can define a new category by typing it into the Category field in the Address
Information portion of the Browse Window, or choose from an existing category by pressing the down 
button next to this field and selecting one of the categories you have entered for other entries. You can 
also add, edit and delete categories with the Edit Categories dialog box. to do this, select Categories from
the Edit menu.



Address Information

The Address Information section of the browse window allows you to view and edit the contact's name, 
address, and Category.

Field Definition
Last Name The contact's last name, maximum 30 characters.
First Name The contact's first name, maximum 30 characters.
Category User defined category, maximum 25 characters.
Company Company name, maximum 40 characters.
Street1 Main street address, maximum 40 characters.
Street2 Alternate street address (i.e. P.O. box...), maximum 40 characters.
City City, maximum 40 characters.
State State abbreviation, maximum 2 characters.
Zipcode Zipcode, maximum 12 characters (up to 5 + 7 format).
Country Country abbreviation or long name, maximum 40 characters.

Dates to Remember

The Dates to Remember section of the browse window allows you to keep track of you personal contact's
birthday, anniversary, or some other date that is significant to remember. Use the Comments edit box to 
enter notes about the dates. There can be up to 255 characters in the Comments edit box.



Phone Numbers

The Phone Numbers section of the browse window allows you to keep track of various phone numbers for
the contact. These fields are preformatted so you do not have to worry about entering    parenthesis or 
brackets. If you have entered your local area code in the Settings dialog, you do not need to enter the 
area code for local phone numbers in these fields. Use the Dial Button next to a phone number to initiate 
a phone call.



E-Mail ID

The E-Mail ID section of the browse window allows you to keep a reference of the contact's electronic 
mail ID such as an Internet address or a CompuServe address. There is room for 30 characters in this 
field.



General Comments

Use the General Comments section of the browse window to enter up to 255 characters of text. You might
use this field to explain who the contact is, reference additional phone numbers, or to explain certain 
information in any of the sections.



Dial Button

The Dial button allows you to dial the phone number listed in the phone number field to the right of the 
button. Contact Browser automatically interprets whether the number is local or long distance by 
comparing the first three digits of the phone number to your local area code. Contact Browser will also 
add your dial prefix, if any, to the number before dialing. (You need to set the local area code and dialing 
prefix in the Settings dialog which is accessed from the Dial menu).
To dial the phone number, user your mouse to click on the button with the picture of a hand holding a 
receiver next to the number you want to dial. (If you have just entered the phone number, make sure you 
have saved the information by using the Save option so Contact Browser can access the number). After 
you have clicked on the Dial Button, Contact Browser will notify you that the connection has been made 
by telling you to pick up your receiver. Pick up your receiver and wait for someone to answer the phone.

To use the dialer feature of Contact Browser, you need to have a modem attached to your computer and a
phone attached to the phone jack on the modem.

See also Dialer dialog



Close command (File menu)

Use this command to close the active window. You can also close a document by using the Close icon on 
the document's window, as shown below:



Import command (File menu)

Use this command to import information from an ASCII text file. This command asks for the name and 
location of the file to import and then presents the Import Dialog in which you match the import data to 
Contact Browser's data fields.

Contact Browser can read comma or TAB separated ASCII files. Contact Browser uses industry standard 
file extensions to identify the delimiter:

Files with a .TXT extension are identified as having fields separated by the TAB character.
Files with a .CSV extension are identified as having fields separated by commas.

All other file extensions will assume the fields are separated by commas.
If needed the import file can be renamed to the appropriate file extension for the type of delimiter it has.

Contact Browser counts the number of fields in the first line of the import file and uses this number to 
validate each subsequent line. If any of the subsequent lines do not have the same number of fields as 
the first line, the record will not be imported and the record will show up on the Import Exceptions Report.

Note:
Comma separated import files can contain "quotation marks" around the fields but this is not necessary. If
the import file is comma separated and a field contains comma as part of the actual data in the field (i.e. 
11232 A Street, Suite 100), the record will not be imported and will show up on the Import Exception 
Report. However, if each record contains quotation marks around each field, the comma will be treated as
a part of the field and the record will imported.

See also: Export



Export Command (File menu)

Use this command to export Contact Browser's database information to an ASCII file. This command 
presents the Export Dialog in which you select the fields and contacts to export, and the file format to 
export to.
See also: Import



Exit command (File menu)

Use this command to end your Contact Browser session.    You can also use the Close command on the 
application Control menu.    Contact Browser prompts you to save documents with unsaved changes.

Shortcuts

Toolbar:
Keys: ALT+F4



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard. This command is only available when 
viewing Reports. Information from the report viewer is copied onto the clipboard in a specific format where
the columns are separated by the tab character and rows are separated by a new line character. This 
makes it easy to copy information from the Contact Browser report viewer to other applications such as 
spread sheets or word processors.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+C



Categories command (Edit menu)

Use this command to edit categories in the Contact Browser database. This command presents the Edit 
Categories dialog in which you can add, change and delete categories.



Call command (Dial menu)

Use this command to dial a phone number.    This command presents the Dialer dialog where you enter 
the phone number you wish to dial.
To make a call, you must have a modem hooked up to your computer with a telephone hooked up to the 
phone jack on the modem.
Before you make your first call you will need to configure Contact Browser to user your modem through 
the Settings dialog.

Shortcut

Toolbar:

See also Dial Settings



Settings command (Dial menu)

Use this command to set the modem parameters for making a phone call.    This command presents the 
Settings dialog where you enter the settings for your modem.

See also Call



New Report command (Reports menu)

Use this command to build customized reports from the Contact Browser database. This command 
presents the Reports dialog where you select the information you want to see on the reports.
You can create virtually any report you want with the customization features of the Reports dialog.    



Labels (Reports menu)

Use this command to print laser printer or dot-matrix labels. Labels can be printed from reports, or from 
the Browse Window. 

If labels are being printed from the Browse Window, this command presents the Label Limits dialog in 
which you can select ranges of contacts and categories to print labels for.

If labels are being printed from a report, this command presents the Label Format dialog from which you 
select the label template to use, edit label templates, and define the label layout. 

Printing labels from a report is the most flexible. You can print labels for all the records on the report, or 
print labels for the records you have selected. Labels printed from reports will print in the order the report 
is sorted in.

Shortcut

Toolbar:
Keys: CTRL+L

Note:
Creating labels that print on dot-matrix or tractor-feed printers usually requires you to adjust the page 
size.    Label sizes other than .5 inch or 1 inch may not fit evenly on the default 11-inch page.
Before you create mailing labels for these printers, you must first set the default printer and paper size in 
Microsoft Windows Control Panel.

Setting Default Printer/Paper Size in Control Panel

To set the default printer and paper size, do the following:

1. In the Printers dialog box in Control Panel, select a dot-matrix
      printer, then choose the Set As Default Printer button. (If you do
      not already have a dot matrix printer driver installed, you must
      first install one.)
2. Choose the Setup button to display the dialog box for that printer.
3. In the Paper Size box, select User-Defined Size.
4. In the User-Defined Size dialog box, select the unit of measurement
      and then type the width and the length of the mailing label page.
      To determine the width, measure from the left edge of the leftmost
      label to the right edge of the rightmost label. To determine the
      length, measure from the top of the first label to the top of the
      second label.
      For example, if you use two-up labels that measure 3 inches by 5
      inches (with .25 inches between), set Unit to 0.01 inches, Width to
      625, and Length to 525.
5. Choose OK twice, then choose Close.

Once you have set up your default paper size for your labels, choose Printer Setup from the File menu in 
Contact Browser and select User Defined Size for the paper size.

REFERENCES: Microsoft Windows "User's Guide," version 3.1, Chapter 6, "Print Manager"



Sort command (Reports menu)

Use this command to sort reports. This command presents the Sort dialog where you select the order in 
which you want the report sorted. This command is only available when a report is active.



Font (Reports menu)

Use this command to select a character font for displaying and printing a report.    This command presents
the Choose Font dialog where you select the font.
This command is only available when a report is active.



Show ToolTips command (Options menu)

To help you learn the buttons on the toolbar, Contact Browser a feature called ToolTips, which is on by 
default. When ToolTips is on, captions displaying the name of each toolbar button appear below the 
mouse pointer as you move the pointer over each button.

To turn ToolTips off or on

From the Options menu menu, choose ToolTips.

ToolTips is on when the command is checked.



Auto Save Changes command (Options menu)

Contact Browser gives you the option to automatically save changes you make to each record, or prompt 
you to save the changes when you issue a command that moves you off the record.

To turn Auto Save Changes off or on

From the Options menu menu, choose Auto Save Changes.

Auto Save Changes is on when the command is checked.



Browse Window Options (Options menu)

For some people, the default browse window may contain more information than they want to see for 
typical editing tasks. To make editing and browsing the database easier, Contact Browser offers several 
different ways to view the database. 

There are five browse windows available:

Complete
Simple Personal
Enhanced Personal
Simple Business
Enhanced Business



Complete (Browse Window Options)

The Complete browse window gives you every field at once. The database is sorted by Last Name, First 
Name, and Company, respectively, and the Index bar is keyed off of the Last Name.

See also: Simple Personal, Enhanced Personal, Simple Business, Enhanced Business



Simple Personal (Browse Window Options)

The Simple Personal browse window concentrates on the most common information relating to personal 
contacts. Simple Personal includes the following fields:

Category
Last Name
First Name
Street 1
City
State
Zipcode
Home Phone

The database is limited to contacts that have either a Last Name or a First Name, but no Company. If no 
records match this criteria, all the fields will be disabled until a record is added by selecting Add, from the 
Record menu.
The database is sorted by Last Name, and First Name, respectively, and the Index bar is keyed off of the 
Last Name.

See also: Complete, Enhanced Personal, Simple Business, Enhanced Business



Enhanced Personal (Browse Window Options)

The Enhanced Personal browse window includes all the fields in the Simple Personal browse window with
the option to include personal date information. Enhanced Personal includes the following fields:

Category
Last Name
First Name
Street 1
City
State
Zipcode
Home Phone
Birth Date
Anniversary
Other Date
Dates Comments

The database is limited to contacts that have either a Last Name or a First Name, but no Company. If no 
records match this criteria, all the fields will be disabled until a record is added by selecting Add, from the 
Record menu.
The database is sorted by Last Name, and First Name, respectively, and the Index bar is keyed off of the 
Last Name.

See also: Complete, Simple Personal, Simple Business, Enhanced Business



Simple Business (Browse Window Options)

The Simple Business browse window concentrates on the most common information relating to business 
contacts. Simple Business includes the following fields:

Category
Company
Street 1
Street 2
City
State
Zipcode
Country
Business Phone
Fax Phone
E-Mail ID

The database is limited to contacts that have information in the Company field. If no records match this 
criteria, all the fields will be disabled until a record is added by selecting Add, from the Record menu.
The database is sorted by Company, Last Name, First Name, respectively, and the Index bar is keyed off 
of the Company Name.

See also: Complete, Simple Personal, Enhanced Personal, Enhanced Business



Enhanced Business (Browse Window Options)

The Enhanced Business browse window includes all the fields in the Simple Business with the contact 
name added as well as additional phone numbers. Enhanced Business includes the following fields:

Category
Last Name
First Name
Company
Street 1
Street 2
City
State
Zipcode
Country
Business Phone
Fax Phone
Cellular Phone
Pager Phone
E-Mail ID
General Comments

The database is limited to contacts that have information in the Company field. If no records match this 
criteria, all the fields will be disabled until a record is added by selecting Add, from the Record menu.
The database is sorted by Company, Last Name, First Name, respectively, and the Index bar is keyed off 
of the Company Name.

See also: Complete, Simple Personal, Enhanced Personal, Simple Business



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in Contact Browser, such as File Open.    A check mark appears next to the menu item when 
the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in Contact Browser,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click On To

Exit Contact Browser.

Go to the first record in the database.

Go to the previous record in the database.

Go to the next record in the database.

Go to the last record in the database.

Find a record in the database.

Add a new record to the database.

Delete the current record from the database.

Erase current changes.

Save current changes / additions.

Dial a phone number.

Create Reports.

Print laser printer and dot-matrix Labels.



Print the active document.

Brings up the help index.

Brings up context help.

Index bar command (View menu)

Use this command to display and hide the Index bar A check mark appears next to the menu item when 
the Index bar is displayed.

See Index bar for help on using the index bar.



Index Bar

The index Bar is displayed across the top of the Browse Window.    The index bar provides quick mouse 
access to records that begin with a particular character. The index bar keys off of either the Last Name 
field or the Company field, depending on which browse window is currently being used. The index bar 
uses the Last Name if the browse window is Complete, Simple Personal, or Enhanced Personal. The 
index bar uses the Company field if the browse window is Simple Business, or Enhanced Business.
Click on the buttons above to see what each one does.



Index Button #
Select this button to go to the first record that has a last name that begins with a number.



Index Button A
Select this button to go to the first record that has a last name that begins with the letter A.



Index Button B
Select this button to go to the first record that has a last name that begins with the letter B.



Index Button C
Select this button to go to the first record that has a last name that begins with the letter C.



Index Button D
Select this button to go to the first record that has a last name that begins with the letter D.



Index Button E
Select this button to go to the first record that has a last name that begins with the letter E.



Index Button F
Select this button to go to the first record that has a last name that begins with the letter F.



Index Button G
Select this button to go to the first record that has a last name that begins with the letter G.



Index Button H
Select this button to go to the first record that has a last name that begins with the letter H.



Index Button I
Select this button to go to the first record that has a last name that begins with the letter I.



Index Button J
Select this button to go to the first record that has a last name that begins with the letter J.



Index Button K
Select this button to go to the first record that has a last name that begins with the letter K.



Index Button L
Select this button to go to the first record that has a last name that begins with the letter L.



Index Button M
Select this button to go to the first record that has a last name that begins with the letter M.



Index Button N
Select this button to go to the first record that has a last name that begins with the letter N.



Index Button O
Select this button to go to the first record that has a last name that begins with the letter O.



Index Button P
Select this button to go to the first record that has a last name that begins with the letter P.



Index Button Q
Select this button to go to the first record that has a last name that begins with the letter Q.



Index Button R
Select this button to go to the first record that has a last name that begins with the letter R.



Index Button S
Select this button to go to the first record that has a last name that begins with the letter S.



Index Button T
Select this button to go to the first record that has a last name that begins with the letter T.



Index Button U
Select this button to go to the first record that has a last name that begins with the letter U.



Index Button V
Select this button to go to the first record that has a last name that begins with the letter V.



Index Button W
Select this button to go to the first record that has a last name that begins with the letter W.



Index Button X
Select this button to go to the first record that has a last name that begins with the letter X.



Index Button Y
Select this button to go to the first record that has a last name that begins with the letter Y.



Index Button Z
Select this button to go to the first record that has a last name that begins with the letter Z.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Contact Browser window.    To display or hide the status 
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Arrange Icons command (Window menu)

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window.



1, 2, ... command (Window menu)

Contact Browser displays a list of currently open document windows at the bottom of the Window menu.    
A check mark appears in front of the document name of the active window.    Choose a document from 
this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Contact Browser and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.

Shortcut

Toolbar:



Using Help command (Help menu)

Use this command for instructions about using Help.



Order Contact Browser (Help menu)

Use this command to bring up an order form for registering and ordering additional copies of Contact 
Browser. Fill out the order form, print a copy of it, and mail it to the address shown on the form.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Contact Browser.



Context Help command 

Use the Context Help command to obtain help on some portion of Contact Browser.    When you choose 
the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then 
click somewhere in the Contact Browser window, such as another Toolbar button.    The Help topic will be 
shown for the item you clicked.

Shortcut

Toolbar:
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Contact Browser window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Contact Browser determines which 
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Contact Browser determines which
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

<< Write application-specific help here. >>



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item changes to 
Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Print command (File menu)

Use this command to print the current document. This command presents a Print dialog box, where you 
may specify the range of pages to be printed, the number of copies, the destination printer, and other 
printer setup options.
When viewing a record in the Browse Window, the print command will print the entire record as it is seen 
on the screen. When viewing a report., the print command will print the report.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the printer and 
printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress Dialog

The Printing dialog box is shown during the time that Contact Browser is sending output to the printer.    
The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When you choose 
this command, the main window will be replaced with a print preview window in which one or two pages 
will be displayed in their printed format.    The print preview toolbar offers you options to view either one or
two pages at a time; move back and forth through the document; zoom in and out of pages; and initiate a 
print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a Print Setup 
dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option 
and select one of the current installed printers shown in the box.    You install printers and configure 
ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of 
printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>



Record menu commands

 The Record menu offers the following commands:

Add Adds a new record to the database.
Delete Deletes a record from the database.
Erase Erases current changes.
Save Saves current record.
First Record Shows the first record in the database
Previous Record Shows the previous record in the database
Next Record Shows the next record in the database
Last Record Shows the last record in the database
Find Finds a record in the database.
Find Next Finds the next record that matches the search criteria specified by the 

Find command.

Add command (Record menu)

Use this command to add a new record to the database. Any additions or changes to the current record 
will be saved when this command is issued.

Shortcut
Toolbar:

Keys: CTRL+A



Delete command (Record menu)

Use this command to delete the current record. This command will be disabled if you are currently adding 
a record or if there is only one record in the database.

Shortcut
Toolbar:

Keys: CTRL+D



Erase command (Record menu)

Use this command to erase any changes you have made to the current record since the last time it was 
saved. If you are currently adding a new record, this command will abort the add.

Shortcut
Toolbar:

Keys: ESC



Save command (Record menu)

Use this command to save any current changes or additions. A record will also be saved when you move 
off by any of the First, Previous, Next, Last or Add commands.

Shortcut
Toolbar:

Keys: CTRL + S



First Record command (Record menu)

Use this command to go to the first record in the database. This command will be disabled if you are 
currently viewing the first record.
Any additions or changes to the current record will be saved when this command is issued.

Shortcut
Toolbar:



Previous Record command (Record menu)

Use this command to go to the previous record in the database. This command will be disabled if you are 
currently viewing the first record.
Any additions or changes to the current record will be saved when this command is issued.

Shortcut
Toolbar:



Next Record command (Record menu)

Use this command to go to the next record in the database.    This command will be disabled if you are 
currently viewing the last record.
Any additions or changes to the current record will be saved when this command is issued.

Shortcut
Toolbar:



Last Record command (Record menu)

Use this command to go to the last record in the database. This command will be disabled if you are 
currently viewing the last record.
Any additions or changes to the current record will be saved when this command is issued.

Shortcut
Toolbar:



Find Command (Record menu)

Use this command to find a record in the database.    This command presents the Find dialog where you 
specify the filter for the record you want to find.

Shortcut
Toolbar:

Keys: ALT + F3



Find Next Command (Record menu)

Use this command to find the next record that matches the search criteria specified in the previous Find 
command.

Shortcut
Keys: F3



Find Dialog (Record menu)

The Find dialog allows you to specify a filter to find the exact record you want and display it in the 
browse window. The first record that matches the specified filter will be the one displayed. If no match 
was found the browse window will keep the record that was already displayed.
You can enter your search parameters into any one or more fields in the Find dialog. The search is case 
insensitive and uses a "begin with" technique. 
Here are some examples of how you might perform a search:

If you want to find the first record that has a last name that begins M:
Type the character M in the Last Name field and choose the OK button.

If you want to find the first record that has a last name of Moore:
Type Moore in the Last Name field and choose the OK button.

If you want to find the first record that has a last name of Moore and lives in Washington:
Type Moore in the Last Name field and WA in the State field, then choose the    OK button.

If you want to find the first record that has a last name of Moore, lives in Washington, resides in 
Redmond, and has a zipcode of 98052:

Type Moore in the Last Name field, Redmond in the City field, WA in the State field, and 
98052 in the Zipcode field.

You can continue to narrow the search to find the exact match you want.

Click on areas of the graphic below to see what each field does.



Last Name
Enter the last name you want to find in this field. You can enter the whole name or just the first part. The 
search does not distinguish between upper and lower case characters.



First Name
Enter the first name you want to find in this field. You can enter the whole name or just the first part. The 
search does not distinguish between upper and lower case characters.



Company
Enter the name of the company you want to find in this field. You can enter the whole name or just the 
first part. The search does not distinguish between upper and lower case characters.



City
Enter the name of the city you want to find in this field. You can enter the whole name or just the first 
part. The search does not distinguish between upper and lower case characters.



State
Enter the name of the state you want to find in this field. You can enter the whole name or just the first 
part. The search does not distinguish between upper and lower case characters.



Zipcode
Enter the zipcode you want to find in this field. You can enter the whole name or just the first part. The 
search does not distinguish between upper and lower case characters.



Country
Enter the name of the country you want to find in this field. You can enter the whole name or just the first
part. The search does not distinguish between upper and lower case characters.



Find button
Executes the search.



Cancel button
Cancels the search.



Help button
Brings up this help topic.



Dialer dialog (Dial menu)

The Dialer dialog allows you to enter a phone number and make a phone call. To make a call, you must 
have a modem hooked up to your computer with a telephone hooked up to the phone jack on the 
modem. 
Use your mouse to click on the buttons on the number pad or use the number keypad on your keyboard 
to enter the phone number you wish to call, then choose the Dial button to initiate the phone call. When 
the connection is made you will see a message box telling you to pick up the receiver.
Use the Pause button to enter a comma in the dial string. This creates a two second pause in the dial 
sequence in case you need to dial a prefix to get an outside line or need a series of pauses between the
phone number and an extension number.
If you have entered a prefix in the Settings dialog, and have the Use Prefix option checked, that prefix 
will automatically be entered into the dial string field.
Click on areas of the graphic below to see what each field does.



Dial String
This field displays the number that will be dialed.



Dial 1
Press this button to dial a 1.



Dial 2
Press this button to dial a 2.



Dial 3
Press this button to dial a 3.



Dial 4
Press this button to dial a 4.



Dial 5
Press this button to dial a 5.



Dial 6
Press this button to dial a 6.



Dial 7
Press this button to dial a 7.



Dial 8
Press this button to dial a 8.



Dial 9
Press this button to dial a 9.



Dial 0
Press this button to dial a 0.



Dial *
Press this button to dial an asterisks.



Dial #
Press this button to dial a #.



Dial Pause
Press this button to enter a two second pause in the dial string.



Dial <<
Press this button to enter remove the last character in the dial string.



Dial button
Press this button to make the phone call.



Cancel button
Press this button close the Dialer dialog without dialing a number.



Settings dialog (Dial menu)

The Settings dialog allows you to set the parameters for your modem so you can use Contact Browser 
to make your phone calls.

Click on areas of the graphic below to see what each field does.



Type
If your modem is capable of tone dialing select the Tone option, otherwise select the pulse option.



Port
Select the COM port your modem is attached to.



Baud Rate
Select the maximum baud rate setting for your modem. If you do not know the baud rate of your modem,
select 2400.



Prefix
If you need to dial a prefix to get an outside line, then enter that number here. Check the Use Prefix 
check box to activate this prefix.



Use Prefix
Check this box to active the prefix entered in the Prefix edit field.



Local Area Code
Enter your local area code here. This is necessary to properly make local phone calls when you click on 
the handset buttons next to the phone numbers in the Browse Window.
Contact Browser uses this information to determine whether a phone number is local or long distance. If 
you click on a handset button that is associated with a number that does not have a local area code, 
Contact Browser will place a 1 before the number when it is dialed.



Ok
Choose this button to save your settings.



Cancel
Choose this button to close the dialog without saving your changes.



Reports dialog (Reports menu)

The Reports dialog allows you to create reports customized to the way you want to see them. The 
Reports dialog has the following main features:

Columns
Use the Columns page of the dialog to select the columns and the order in which the columns 
appear on the report. A column is a field from the database such as Last Name or Company.

Contacts
Use the Contacts page of the dialog to select the contacts you want to have included in the 
report. A Contact refers to a particular record which could be a person or a company, depending 
on how you have entered the information into the browse form.

Options/Limits
Use the Options/Limits page of the dialog to set the limits and options for the report. You can limit 
the report to information from any of the major fields. For instance, you can run a report for a 
particular Category, or get a list of everyone from a particular state. You can also set options to 
save your settings for the next time you run reports.



Columns

Choose the columns you want on the report by moving column names from the Unselected list to the 
Selected list. The order in which you build the Selected column list will be the order in which these 
columns are displayed on the report (from left to right).

There are several ways to build your column list:

Selecting Columns using Drag and Drop
Choose a column name from the Unselected list box by positioning the mouse pointer over the 
name and pressing down the left mouse button. While still holding down the left mouse button, 
move (drag) the mouse pointer over the Selected list box and let go of the left mouse button. The 
name will be dropped into the Selected list box. The position of the dropped column will be 
wherever the tip of the mouse pointer was positioned when you released the left mouse button. 
You can remove items from the Selected list box by dragging them from the Selected list box and 
dropping them into the Unused list box.

Selecting Columns without using Drag and Drop
Select a column name from the Unselected list box by clicking on it once with the left mouse 
button or press Alt+N on the keyboard and use the up and down arrow keys to select the item you
want added. Choose the Add button by clicking on it or press Alt+A on the keyboard. The column 
will be transferred to the Selected list box.
To remove an item from the Selected list box, select it by clicking on it once with the left mouse 
button or press Alt+S on the keyboard and use the up and down arrow keys to highlight the item 
you want. Choose the Remove button by clicking on it or press Alt+R on the keyboard. The 
Column will be transferred to the Unused list box.

Add All/Remove All
You can add every column to the report by choosing the Add All (Alt+L) button or start over by 
choosing the Remove All (Alt+M) button.

Rearranging Columns in the Selected List Box
You can arrange the order in which the selected columns will appear on the reports by dragging a
column from one point in the Selected list to another point in the Selected list box. 
You can also select an item in the Selected list box and use the Move Up (Alt+U) and Move Down
(Alt+D) buttons to change the order of the selected columns.

Click on areas of the graphic below to see what each field does.



See also Contacts, Options/Limits



Columns
Select this button to go to the Columns page of the Reports dialog.



Contacts
Select this button to go to the Contacts page of the Reports dialog.



Options/Limits
Select this button to go to the Options/Limits page of the Reports dialog.



Unused
The Unused list box contains the columns that will not show up on the report.



Selected
The Selected list box contains the columns that will show up on the report in the order they will appear.



Add
Use this button to add to the report the item that is highlighted in the Unused list box. This button is 
disabled if no items are highlighted in the Unused list box.



Remove
Use this button to remove the highlighted item from the Selected list box. This button is disabled if no 
items are highlighted in the Selected list box.



Add All
Use this button to add every column to the report. This button is disabled if no items are left in the Unused
list box.



Remove All
Use this button to remove all items from the Selected list box and put them in the Unused list box. This 
button is disabled if no items are left in the Selected list box.



OK
Use this button to close the Reports dialog and display the report.



Cancel
Use this button to close the Reports dialog without creating a report.



Move Up
Use this button to move an item in the Selected list box up. This button is disabled if there if no items are 
highlighted in the Selected list box.



Move Down
Use this button to move an item in the Selected list box down. This button is disabled if there if no items 
are highlighted in the Selected list box.



Load Contacts
Use this button to load all contacts into the list box.



Contacts

Initially this page comes up with no contacts loaded. If you want to individually select contacts for the 
report, choose the Load Contacts button to fill out the list box.
Choose the contacts you want on the report by moving names from the Unselected list to the Selected 
list. The Selected names will appear in alphabetical order. 
Another way to select the contacts that will appear on the report is to set limits in the Options/Limits page 
of the dialog. If you choose to set limits on that page it will override the contacts you select on this page.

There are several ways to build your contact list:
Selecting Contacts using Drag and Drop

Choose a name from the Unselected list box by positioning the mouse pointer over the name and
pressing down the left mouse button. While still holding down the left mouse button, move (drag) 
the mouse pointer over the Selected list box and let go of the left mouse button. The name will be 
dropped into the Selected list box. The position of the dropped column will be wherever the tip of 
the mouse pointer was positioned when you released the left mouse button. 
You can remove items from the Selected list box by dragging them from the Selected list box and 
dropping them into the Unused list box.

Selecting Contacts without using Drag and Drop
Select a name from the Unselected list box by clicking on it once with the left mouse button or 
press Alt+N on the keyboard and use the up and down arrow keys to select the item you want 
added. Choose the Add button by clicking on it or press Alt+A on the keyboard. The column will 
be transferred to the Selected list box.
To remove an item from the Selected list box, select it by clicking on it once with the left mouse 
button or press Alt+S on the keyboard and use the up and down arrow keys to highlight the item 
you want. Choose the Remove button by clicking on it or press Alt+R on the keyboard. The name 
will be transferred to the Unused list box.

Add All/Remove All
You can add every name to the report by choosing the Add All (Alt+L) button or start over by 
choosing the Remove All (Alt+M) button.

Click on areas of the graphic below to see what each field does.



See also Columns, Options/Limits



Unused
The Unused list box contains the contacts that will not show up on the report.



Selected
The Selected list box contains the contacts that will show up on the report.



Options/Limits

The Options/Limits page lets you limit the report to certain information and select options to save your 
settings for the next time you run a report. If you choose to specify limits for the report, any contacts you 
select for the report via the Contacts page of the Reports dialog will be ignored.
The Limits portion works similar to the Find dialog. You can specify parameters to limit the information that
is displayed on the report by typing the information in it's respective field. For instance, if you want to 
create a report listing everyone in the city of San Diego, type "San Diego" in the City field. If you want a 
listing of all the contacts with the last name Moore in San Diego, type "Moore" in the last name field, and 
"San Diego" in the city field.
You can also select one or more Categories to display on the report. For example, you might have a 
Category for family and another for friends. If you want to create a listing of all your family members, 
highlight its category in the category list box. If you want to create a listing for family and friends, highlight 
both categories.
The Options portion allows you to specify whether you want to display vertical or horizontal grid lines, or 
save your settings for the next time you run the report.

Click on areas of the graphic below to see what each field does.

See also Columns, Contacts



Last Name
Enter the last name you want to limit the report to. You can enter the whole name or just the first part. 
The search does not distinguish between upper and lower case characters.



First Name
Enter the first name you want to limit the report to. You can enter the whole name or just the first part. 
The search does not distinguish between upper and lower case characters.



Company
Enter the name of the company you want to limit the report to. You can enter the whole name or just the 
first part. The search does not distinguish between upper and lower case characters.



City
Enter the name of the city you want to limit the report to. You can enter the whole name or just the first 
part. The search does not distinguish between upper and lower case characters.



State
Enter the name of the state you want to limit the report to. You can enter the whole name or just the first 
part. The search does not distinguish between upper and lower case characters.



Zipcode
Enter the zipcode you want to limit the report to. You can enter the whole name or just the first part. The 
search does not distinguish between upper and lower case characters.



Country
Enter the name of the country you want to limit the report to. You can enter the whole name or just the 
first part. The search does not distinguish between upper and lower case characters.



Category
Select one or more categories to limit the report to.



Horizontal Grid Lines
If this box is checked, the report will display lines between rows.



Vertical Grid Lines
If this box is checked, the report will display lines between columns.



Save Column Selection
If this box is checked, the columns that were selected on the Columns page will automatically be selected
the next time the Reports dialog is run.



Save Limits
If this box is checked, the any limits you have entered will automatically be set the next time the Reports 
dialog is run.



Sort dialog (Reports menu)

The sort dialog allows you the change the order in which the information on the currently active report is 
displayed. From the sort dialog, you select the primary, secondary, and third sort. The three drop down list
boxes will only offer choices for the columns that are displayed on the report you are changing the sort 
for. You can choose the sort in ascending order (i.e. A to Z), or descending order (i.e. Z to A). You can also
choose to ignore the difference between capital and lower case letters. For example, in the ASCII 
character set, all capital letters come before lower case letters, so lower case 'a'    would come after upper
case 'Z'. If you want to group together all names with the same characters regardless of whether they are 
upper or lower case, choose the Ignore Case option.
The default sort order is by Last Name, First Name, and Company, respectively. To change the sort order, 
select the first second and third sort from the sort dialog. For example, if you want to see all your contacts
from the same state and city grouped together and in last name order, then from the sort dialog, choose 
State from Sort Column 1, City from Sort Column 2, and Last Name from Sort Column 3. 

Click on areas of the graphic below to see what each field does.



Sort Column 1
Select the column you want to have as the primary sort.



Sort Column 2
Select the column you want to have as the secondary sort.



Sort Column 3
Select the column you want to have as the third sort.



Ascending
Choose ascending to sort the column in 0-9 A-Z order.



Descending
Choose ascending to sort the column in Z-A 9-0 order.



Ignore Case
Choose ignore case to make the sort case insensitive.



OK
Choose the OK button to close the sort dialog and resort the report.



Cancel
Choose the Cancel button to close the sort dialog without resorting the report.



Edit Categories dialog (Edit menu)

The Edit Categories dialog allows you to add new categories to the database, change existing categories,
and delete existing categories.

Add
Choose Add to enter a new category in the database. This is useful if you choose to enter all the 
categories you plan on using ahead of time. You can then simply choose from your list of predefined 
categories when entering a new contact in the Browse Window.

Change
Choose Change to change the names of existing categories in the database. This function will search 
the database for each record that matches the category you are changing and change it to the new 
name you enter. You can choose to keep the old category name or delete it.

Delete
Choose Delete to remove categories from the database. This function will search the database for 
each record that matches the category you are deleting and clear its category field.

See also: Category



Label Format Dialog (Reports Menu)

Use the Label Format dialog to choose the label template to use for printing, modify label templates, 
define the label layout, and set various parameters for printing:

Label Format
Choose the label template you wish to use for printing from the Label Format list box.

Edit Label Format
Choose Edit Label Format to edit the currently selected label format. This command presents the Edit 
Label Format dialog box in which you set the dimensions of the label template, and add and delete 
label templates.

Field Layout
The Field Layout displays the current label layout. This is the information that will print on the labels.

Edit Field Layout
Choose Edit Field Layout the define the information that will print on the labels. This command 
presents the Edit Field Layout dialog in which you define the label layout.

Start At
Choose the row and column to start printing labels at.

Copies Each
Select the number of labels to print for each record.

Print Labels
Choose this button the start printing labels.

Cancel
Cancels printing labels.

Help
Brings up this help topic.

Test Print
Choosing this button will print out a test sheet for you to verify that the current label dimensions are 
accurate for your printer. If the dimensions need to be modified, choose Edit Label Format to make the
necessary modifications.



Edit Label Format dialog

Use the Edit Label Format dialog to set the dimensions of a label template, and add and delete label 
templates:

Template
Select a template to modify from the template combo box.
Update

Select Update to save the current changes to the label template. This button is only active if you 
have made changes to a template. 
Changing the template selection aborts any changes.

Add
Select Add to add a new label template. This button becomes active when you change the text in 
the template edit field.

Delete
Select Delete to delete the currently selected label template.

Label Dimensions
Modify the label dimensions group to change the dimensions of the currently selected label template.
The dimensions shown in each edit field is in .01 inches. For example, 100 is equal to 1.00", and 350 
is equal to 3.50".

Page Layout
Use the Page Layout to select the number of rows and columns on the label template.

Load All Defaults
Load All Defaults will load the original label templates. Any changes you have made to any of the label 
templates that came with Contact Browser will be overwritten by this command.

Font
Select a Font to use for printing labels.

Close
Closes the dialog and saves any changes that were made to the current template.

Cancel
Cancels the dialog and aborts the current changes

Help
Brings up this help topic.

Note:
Creating labels that print on dot-matrix or tractor-feed printers usually requires you to adjust the page 
size.    Label sizes other than .5 inch or 1 inch may not fit evenly on the default 11-inch page.
Before you create mailing labels for these printers, you must first set the default printer and paper size in
Microsoft Windows Control Panel.

Setting Default Printer/Paper Size in Control Panel

To set the default printer and paper size, do the following:



1. In the Printers dialog box in Control Panel, select a dot-matrix
      printer, then choose the Set As Default Printer button. (If you do
      not already have a dot matrix printer driver installed, you must
      first install one.)
2. Choose the Setup button to display the dialog box for that printer.
3. In the Paper Size box, select User-Defined Size.
4. In the User-Defined Size dialog box, select the unit of measurement
      and then type the width and the length of the mailing label page.
      To determine the width, measure from the left edge of the leftmost
      label to the right edge of the rightmost label. To determine the
      length, measure from the top of the first label to the top of the
      second label.
      For example, if you use two-up labels that measure 3 inches by 5
      inches (with .25 inches between), set Unit to 0.01 inches, Width to
      625, and Length to 525.
5. Choose OK twice, then choose Close.

Once you have set up your default paper size for your labels, choose Printer Setup from the File menu 
in Contact Browser and select User Defined Size for the paper size.

REFERENCES: Microsoft Windows "User's Guide," version 3.1, Chapter 6, "Print Manager"



Edit Field Layout dialog

Use the Edit Field Layout dialog to define the information that will appear on the label.
Select a field from the Available Fields list box and choose the ">" button to add it to the layout. Select the
Newline button to add new lines to the layout. Choosing one of the punctuation buttons will add that 
character to the layout. You can also type in your own text in the text edit field and choose the Text button
to add it to the layout. Use the "<" to remove the last entry from the layout.



Label Limits dialog

Use the Label Limits dialog to set a range of contacts to print labels for. You can enter parameters into 
any one or more fields in the Label Limits dialog or select one or more categories to print labels for. 
Setting label limits works the same way as setting limits for reports. See the Options/Limits section of the 
Reports dialog for an explanation of how this works.



Import dialog

The Import dialog is used to match import data to Contact Browser fields. The Import Data list box 
contains the fields available in the import file. 
To match an import data field to a Contact Browser data field, select a field in the Import Data list box, 
then click on its corresponding field in the Available Fields list box. The defined match will then appear in 
the Defined Matches list box. 
If an import data field does not have a corresponding Contact Browser data field, select the (Do Not 
Match) item in the Available Fields list box. This causes that field to be ignored during the import process. 
To remove a match, select the defined match to remove in the Defined Matches list box and choose the 
Remove Match button.
You can scroll forwards through the import data by choosing the ">>" button above the Import Data list 
box, or scroll backwards by choosing the "<<" button.



Export dialog

The Export dialog allows you to create a customized export file. The Export dialog has the following 
main features:

Fields
Use the Fields page of the dialog to select the data fields to export and the order in which the 
fields will appear in the export file.

Contacts
Use the Contacts page of the dialog to select the contacts you want to export. A Contact refers to 
a particular record which could be a person or a company, depending on how you have entered 
the information into the browse form.

Limits
Use the Limits page of the dialog to set the limits for the export. You can limit the export to 
information from any of the major fields. For instance, you can export all of the records for a 
particular Category, or export all of the records for all contacts from a particular state.

Options
Use the Options page of the dialog to specify the format of the export file and to save certain 
options.



Export Fields

Choose the fields you want on the report by moving field names from the Unselected list to the Selected 
list. The order in which you build the Selected field list will be the order in which these fields are placed in 
the export file (from left to right).

There are several ways to build your field list:

Selecting fields using Drag and Drop
Choose a field name from the Unselected list box by positioning the mouse pointer over the name
and pressing down the left mouse button. While still holding down the left mouse button, move 
(drag) the mouse pointer over the Selected list box and let go of the left mouse button. The name 
will be dropped into the Selected list box. The position of the dropped field will be wherever the tip
of the mouse pointer was positioned when you released the left mouse button. 
You can remove items from the Selected list box by dragging them from the Selected list box and 
dropping them into the Unused list box.

Selecting Fields without using Drag and Drop
Select a field name from the Unselected list box by clicking on it once with the left mouse button 
or press Alt+N on the keyboard and use the up and down arrow keys to select the item you want 
added. Choose the Add button by clicking on it or press Alt+A on the keyboard. The field will be 
transferred to the Selected list box.
To remove an item from the Selected list box, select it by clicking on it once with the left mouse 
button or press Alt+S on the keyboard and use the up and down arrow keys to highlight the item 
you want. Choose the Remove button by clicking on it or press Alt+R on the keyboard. The field 
will be transferred to the Unused list box.

Add All/Remove All
You can add every field to export by choosing the Add All (Alt+L) button or start over by choosing 
the Remove All (Alt+M) button.

Rearranging fields in the Selected List Box
You can arrange the order in which the selected fields will appear in the export file by dragging a 
field from one point in the Selected list to another point in the Selected list box. 
You can also select an item in the Selected list box and use the Move Up (Alt+U) and Move Down
(Alt+D) buttons to change the order of the selected columns.

See also Contacts, Limits, Options



Export Contacts

Initially this page comes up with no contacts loaded. If you want to individually select contacts to export, 
choose the Load Contacts button to fill out the list box.
Choose the contacts you want to export by moving names from the Unselected list to the Selected list. 
The Selected names will appear in alphabetical order. 
Another way to select the contacts to export is to set limits in the Limits page of the dialog. If you choose 
to set limits on that page it will override the contacts you select on this page.

There are several ways to build your contact list:
Selecting Contacts using Drag and Drop

Choose a name from the Unselected list box by positioning the mouse pointer over the name and
pressing down the left mouse button. While still holding down the left mouse button, move (drag) 
the mouse pointer over the Selected list box and let go of the left mouse button. The name will be 
dropped into the Selected list box. The position of the dropped column will be wherever the tip of 
the mouse pointer was positioned when you released the left mouse button. 
You can remove items from the Selected list box by dragging them from the Selected list box and 
dropping them into the Unused list box.

Selecting Contacts without using Drag and Drop
Select a name from the Unselected list box by clicking on it once with the left mouse button or 
press Alt+N on the keyboard and use the up and down arrow keys to select the item you want 
added. Choose the Add button by clicking on it or press Alt+A on the keyboard. The column will 
be transferred to the Selected list box.
To remove an item from the Selected list box, select it by clicking on it once with the left mouse 
button or press Alt+S on the keyboard and use the up and down arrow keys to highlight the item 
you want. Choose the Remove button by clicking on it or press Alt+R on the keyboard. The name 
will be transferred to the Unused list box.

Add All/Remove All
You can select every contact for export by choosing the Add All (Alt+L) button or start over by 
choosing the Remove All (Alt+M) button.

See also Fields, Limits, Options



Export Limits

The Limits page lets you limit the export to certain information. If you choose to specify limits for the 
export, any contacts you select for the export via the Contacts page of the Export dialog will be ignored.
The Limits portion works similar to the Find dialog. You can specify parameters to limit the information that
is exported by typing the information in it's respective field. For instance, if you want to create an export 
file for everyone in the city of San Diego, type "San Diego" in the City field. If you want to create an export
file for all the contacts with the last name Moore in San Diego, type "Moore" in the last name field, and 
"San Diego" in the city field.
You can also select one or more Categories to export. For example, you might have a Category for family 
and another for friends. If you want to create an export file listing of all your family members, highlight its 
category in the category list box. If you want to create an export file listing family and friends, highlight 
both categories.

See also Fields, Contacts, Options



 Export Options

The Options page lets you select the export file format and to save you field and limits selection for the 
next time you export.
Choose the Comma Separated radio button to export to a comma separated file format.
Choose the Tab Delimited radio button to export to a TAB delimited file format.
Check the Quotes check box to put quotes around all data fields in the export file.




